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Chapter 201

Tests for Two
Proportions in a
Repeated Measures
Design
Introduction
This module calculates the power for testing the time-averaged difference (TAD) between two proportions in a
repeated measures design. A repeated measures design is one in which subjects are observed repeatedly over
time. Measurements may be taken at pre-determined intervals (e.g. weekly or at specified time points following
the administration of a particular treatment), or at random times with variable intervals between repeated
measurements.
This type of time-averaged difference analysis is often used when the outcome to be measured varies with time.
For example, suppose that you want to compare two treatment groups based on a certain binary response variable
such as the presence (or absence) of a disease. The disease status may change over time, depending on various
factors unrelated to the treatment. The precision of the experiment is increased by taking multiple measurements
from each individual and comparing the time-averaged difference in proportions between the two groups. Care
must be taken in the analysis because of the correlation that is introduced when several measurements are taken
from the same individual. The covariance structure may take on several forms depending on the nature of the
experiment and the subjects involved. This procedure allows you to calculate sample sizes and power using four
different covariance patterns: Compound Symmetry, AR(1), Banded(1), and Simple.
This procedure can be used to calculate sample size and power for tests of pairwise contrasts in a mixed models
analysis of repeated measures data. Mixed models analysis of repeated measures data is also employed to provide
more flexibility in covariance specification and a greater degree of robustness in the presence of missing data,
provided that the data can be assumed to be missing at random.
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Technical Details
Two Test Statistics
This routine has the capability of calculating power and sample size for testing time-averaged difference in
proportions based on two different test statistics. The first test statistic is presented in Liu and Wu (2005) and
Diggle et al. (1994). The test statistic is based on the difference in proportions:

d = p1 − p2 ,
and has the form

z=

pˆ 1 − pˆ 2
.
var( pˆ 1 − pˆ 2 )

The second type of test statistic, presented in Brown and Prescott (2006), has application to mixed models
analysis of repeated measures data where there aren’t any random effects other than the subjects themselves, and
is based on the difference in proportions defined on the logit link scale:
 p 
 p 
d = log(OR ) = log 1  − log 2  = logit( p1 ) − logit( p 2 ) ,
 1 − p1 
 1 − p2 

and has the form
z=

logit( pˆ j ) − logit( pˆ h )
var(logit( pˆ j ) − logit( pˆ h ))

.

Testing the Time-Averaged Difference between Two Proportions
Theory and Notation
The following derivation is based on the results in Liu and Wu (2005). For a study with n1 subjects in group 1,
having success proportion p1, and n2 subjects in group 2, having success proportion p2 (for a total of N subjects),
each measured m times, the time-averaged difference (d = p1 – p2) in proportions between the two groups can be
estimated using the following model:
E ( y ij | xij ) = Pr( y ij = 1 | xij ) = β 0 + β1 xij , i = 1,, N ; j = 1,, m ,

where
y ij is the jth binary response from subject i,

β 0 is the model intercept,

β1 is the treatment effect or the time-averaged difference in proportions between groups 1 and 2 (i.e. β1 = d
),
xij is a binary group assignment variable, which is equal to 1 if the ith subject is in group 1 and equal to 0 if

the ith subject is in group 2.
The proportions used to find the difference might be expressed directly as p1 and p2, or indirectly as p2 and an odds
ratio

ψ=

p1 (1 − p1 ) p1q2
.
=
p 2 (1 − p 2 ) p 2 q1
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The proportion from group 1 can then be computed as
p1 =

ψp 2

1 − p 2 + ψp 2

.

Accounting for the relationship between repeated measurements, the model presented above can be written in
matrix form as

E ( y i | xi ) = X i ' β ,
where

y i = ( y i1

yi 2  yim )' is an m × 1 vector of responses from subject i,

1

1
Xi = 


1

1

1
if the ith subject is in group 1,


1 m×2

1

1
Xi = 


1

0

0
if the ith subject is in group 2, and


0  m×2

β 
β =  0  is the vector of model parameters.
 β1 

We can stack the data in a single vector and matrix form as follows:
y = ( y 1 ' , y 2 ' ,, y N ' )'
X = ( X 1 , ' X 2 , ', X N ' )'

and the model for the N equations can be compressed into one as
E ( y | x) = X' β ,

with
V = var( y )
0 
 R1 0


=σ  0  0 
 0 0 R 
N 

2

= σ 2R

as the covariance (or variance-covariance) matrix.

Model Estimation
ˆ = σˆ 2 R
ˆ , then estimates of the regression coefficients from the above regression model are given as
With V
 βˆ 
βˆ =  0 
ˆ
 β1 
ˆ −1X ) −1 X ' V
ˆ −1 y ,
= (X' V
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and the variance of β̂ is estimated as
 var( βˆ0 )
cov( βˆ0 , βˆ1 ) 
var(βˆ ) = 
ˆ ˆ
var( βˆ1 ) 
 cov( β 0 , β1 )
ˆ −1X ) −1
= (X' V

ˆ −1X ) −1 .
= σˆ 2 ( X ' R

Since the data are binary, the variance term σ 2 depends on the proportions p1 and p2 . Under the null hypothesis,
H0, the estimate of σ 2 is
 n1 p1 + n 2 p 2 

1 −
n1 + n 2 

(n p + n2 p2 )(n1q1 + n2 q2 ) ,
= 1 1
( n1 + n 2 ) 2

σˆ 02 =

n1 p1 + n 2 p 2
n1 + n 2

where q1 = 1 − p1 and q2 = 1 − p 2 . Under the alternative hypothesis, H1, the estimate of σ 2 is

σˆ 12 =
=

n2
n1
p 2 q2
p1q1 +
n1 + n 2
n1 + n 2
n1 p1q1 + n 2 p 2 q2
.
n1 + n 2

The estimated variance of βˆ1 under the null hypothesis is

[

]

ˆ −1X ) −1 ,
var( βˆ1 | H 0 ) = σˆ β2 ,H = σˆ 02 ( X ' R
11
1

0

and the estimated variance of βˆ1 under the alternative hypothesis is

[

]

ˆ −1 X ) −1 ,
var( βˆ1 | H 1 ) = σˆ β2 ,H = σˆ 12 ( X ' R
11
1

1

where [A]11 denotes the lower right-hand element of a 2 × 2 matrix, A.

Hypothesis Test
A two-sided test of the null hypothesis that the time-averaged difference in proportions is equal to zero is
equivalent to the test of H 0 : β1 = 0 vs. H 1 : β1 ≠ 0 . Similarly, the upper and lower one-sided tests are
H 0 : β1 ≤ 0 vs. H 1 : β1 > 0 and H 0 : β1 ≥ 0 vs. H 1 : β1 < 0 , respectively. The test can be carried out using the test
statistic

z=

βˆ1
var( βˆ1 )

=

pˆ 1 − pˆ 2
→ N (0,1) .
var( pˆ 1 − pˆ 2 )

Power Calculations
Sample sizes for repeated measures studies are often calculated as if a simple trial with no repeated measures was
planned, which results in a higher calculated sample size than would be found if the correlation between repeated
measures were taken into consideration. With an idea of the correct covariance structure, and an estimate of the
within-patient correlation, you can get a better estimate of the power and sample size necessary to achieve your
objectives. If you have no indication of the correct covariance structure for the experiment, then the compound
symmetry (program default) is likely to be adequate. If you have no previous estimate of the within-patient
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correlation, then Brown and Prescott (2006) suggest using a conservative prediction of the correlation, i.e. a
higher correlation than anticipated.
For a two-sided test where it is assumed that d > 0 (without loss of generality),
Power = 1 − β = Pr( rejecting H 0 | H 1 )


βˆ1


= Pr 
> z1−α / 2 | H 1 
 var( βˆ1 )





ˆ
β1
≈ Pr 
> z1−α / 2 | H 1  since it is assumed that d > 0


ˆ
 var( β1 )

 βˆ − d

d
= Pr  1
> z1−α / 2 −
| H1 
 σˆ 

σˆ β ,H
1
0

 β1 ,H 0
 βˆ − d σˆ β ,H

d
= Pr  1
⋅ 1 1 > z1−α / 2 −
| H1 
 σˆ 

σˆ β ,H
σˆ β ,H
1
0
1
0
 β1 ,H1


 βˆ − d σˆ β ,H

d
= Pr  1
> 1 0 ⋅ z1−α / 2 −
| H1 
 σˆ 

σˆ β ,H
σˆ β ,H
1
1
1
1
 β1 ,H1


 σˆ β ,H
d 
= 1 − Φ  1 0 ⋅ z1−α / 2 −
,
 σˆ 
σˆ β ,H 
H
β
,
1
1 
 1 1

where Φ() is the standard normal density function, and α and β are the probabilities of type I and type II error,
respectively. For a one-sided test, α is used in place of α/2.

Testing Two Proportions using the Time-Averaged Difference defined on
the Logit Link Scale (Testing Pairwise Contrasts of Fixed Effects in Mixed
Models)
Mixed Models Theory and Notation
The following derivation is based on the results in Brown and Prescott (2006) and Liu and Wu (2005). A
generalized linear mixed model incorporates both fixed and random effects. Fixed effects are those effects in the
model whose values are assumed constant, or unchanging. Random effects are those effects in the model that are
assumed to have arisen from a distribution, resulting in another source of random variation other than residual
variation. For an experiment with N subjects, p fixed effect parameters, and q random effect parameters, the
generalized linear mixed model can be expressed using matrix notation as

y i = μ i + ε i , i = 1,, N
where

y i is an ni × 1 vector of responses for subject i,
μ i is an ni × 1 vector of expected means for subject i, and is linked to the model parameters by a link function, g:
 log(π i /(1 − π i )) 


 log(π i /(1 − π i )) 
g (μ i ) = log it (μ i ) = 
= X i β + Z i u i , i = 1,, N




 log(π i /(1 − π i ))  n ×1
i
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where

π i is the probability of success from a bernoulli distribution for individual i,
X i is an ni × p , full-rank design matrix of fixed effects for subject i,
β is a p × 1 vector of fixed effects parameters,

Z i is an ni × q design matrix of the random effects for subject i,
ui is a q × 1 vector of random effects for subject i which has means of zero and scaled covariance matrix G,

ε i is an ni × 1 vector of errors for subject i with zero mean and scaled covariance Σ i .
We can stack the data in a single vector and matrix form as follows:
y = ( y 1 , y 2 ,, y N )'
μ = (μ1 , μ 2 ,, μ N )'
X = ( X 1 , X 2 ,, X N )'
0 
 Z1 0


Z= 0  0 
0 0 Z 
N 

u = ( u1 , u 2 ,, u N )'
ε = (ε1 , ε 2 ,, ε N )'

and the mixed model for the N equations can be compressed into one as

y =μ+ε
with
g (μ) = log it (μ) = Xβ + Zu .

The covariance of y , var( y ) = V , can then be written as
0 
 V1 0


V= 0  0 
0 0 V 
N 

= var(μ + ε )
= var(μ) + Σ
≈ BZGZ' B + B1 / 2 RB1 / 2 ,

where
0
0
0
 π 1 (1 − π 1 )



0
π 2 (1 − π 2 ) 0
0


B=



0
0


 π N (1 − π N ) 
0
0


R is the correlation matrix defined on the linear scale.
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Mixed Models Estimation
In order to fit the generalized linear mixed model, a pseudo-variable z must be introduced to transform y onto the
linear scale. More specifically,
z = g ( μ ) + ( y − μ ) B −1
= Xβ + Zu + ( y − μ)B −1

and z has variance

Vz = var( Xβ + Zu) + B −1 var( y − μ)B −1
= ZGZ'+ B −1 / 2 RB −1 / 2
If ZGZ' = 0 (which is the case when no random effects are included in the model), then
Vz = B −1 / 2 RB −1 / 2 .

Estimates of the variance components are found using maximum likelihood (ML) or restricted/residual maximum
likelihood (REML) methods. The fixed effects are then estimated as
ˆ −1 X ) −1 X ' V
ˆ −1 y
βˆ = ( X ' V
z
z

with the variance estimated as
ˆ −1 X ) −1
var(βˆ ) = ( X ' V
z

These estimation equations are nearly identical to the TAD estimation equations presented earlier, except for the
fact that β may contain more than two parameters, i.e. a parameter for each fixed effect being modeled. In the
TAD model presented above, β1 represents the difference between two treatment proportions. In the generalized
mixed model formulation presented here, β1 , β 2 , etc. represent individual proportions defined on the logit link
scale.

Testing Fixed Effects
Significance tests for fixed or random effects can be done using tests based on the t distribution. We can define
tests of fixed and random effects as contrasts
C = L' βˆ = 0 ,

respectively. For example, in a trial containing three treatments A, B, and C, a pairwise comparison of treatments
A and C is given by the contrast
C AC = L' βˆ = (0 1 0 − 1) βˆ = βˆ A − βˆC ,

where the first term in β is the intercept term, and the other three terms are the treatment effects.
For a single comparison, the Wald test statistic is given by
z=
=
=

L' βˆ
var( L' βˆ )
βˆ − βˆ
j

h

var( βˆ j − βˆh )
logit( pˆ j ) − logit( pˆ h )
var(logit( pˆ j ) − logit( pˆ h ))

→ N (0,1),

201-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Proportions in a Repeated Measures Design

where βˆ j and βˆh ( j ≠ h ) are estimated treatment effects defined on the logit link scale and p j and p h are the
proportions from groups j and h, respectively.
Since the data are binary, var ( βˆ j − βˆh ) depends on the proportions pj and ph. Under the null hypothesis, H0, the
estimate of var ( βˆ − βˆ ) is
j

h

var( βˆ j − βˆh | H 0 ) = σˆ β2ˆ

ˆ
j − βh ,H 0
−1
−1

ˆ X) L
= L' ( X ' V
z
(n j + nh ) 2
ˆ −1X ) −1 L,
=
L' ( X ' R
( n j p j + n h p h )( n j q j + n h qh )

where qk = 1 − pk . Under the alternative hypothesis, H1, the estimate of var ( βˆ j − βˆh ) is
var( βˆ j − βˆh | H 1 ) = σˆ β2ˆ

ˆ
j − β h , H1
−1
−1

ˆ X) L
= L' ( X ' V
z
n j + nh
ˆ −1X ) −1 L,
L' ( X ' R
=
n j p j q j + n h p h qh

In practice, the test is often performed using software containing generalized linear models capability, such as
SAS® PROC GLIMMIX or SAS® PROC GENMOD with a REPEATED statement. The test of the difference in
proportions is generated with an estimation statement such as
ESTIMATE 'A-C' treat 1 0 -1;

or

LSMEANS treat/ PDIFF;

The latter statement would produce tests of all pairwise comparisons of the levels of the treatment variable,
defined on the logit link scale. The former would only test the difference between groups A and C. Of course,
these comparison statements must be used in conjunction with appropriate model and class statements.

Power Calculations
Sample sizes for repeated measures studies are often calculated as if a simple trial with no repeated measures was
planned, which results in a higher calculated sample size than would be found if the correlation between repeated
measures were taken into consideration. With an idea of the correct covariance structure, and an estimate of the
within-patient correlation, you can get a better estimate of the power and sample size necessary to achieve your
objectives. If you have no indication of the correct covariance structure for the experiment, then the compound
symmetry (program default) is likely to be adequate. If you have no previous estimate of the within-patient
correlation, then Brown and Prescott (2006) suggest using a conservative prediction of the correlation, i.e. a
higher correlation than anticipated.
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For a two-sided test where it is assumed that

βˆ j − βˆh > 0

(without loss of generality),

Power = 1 − β = Pr( rejecting H 0 | H 1 )


= Pr 



βˆ j − βˆh
var( βˆ j − βˆh )

> z1−α / 2



| H1 





βˆ j − βˆh


> z1−α / 2 | H 1  since it is assumed that d > 0
≈ Pr 

 var( βˆ j − βˆh )



 βˆ − d
d
| H1 
= Pr  1
> z1−α / 2 −

 σˆ ˆ ˆ
σˆ βˆ − βˆ ,H
0
j
h

 β j − βh ,H 0

 βˆ − βˆ − d σˆ βˆ − βˆ ,H
d
j
h
| H1 
⋅ j h 1 > z1−α / 2 −
= Pr 

 σˆ ˆ ˆ
σˆ βˆ − βˆ ,H
σˆ βˆ − βˆ ,H
0
0
j
h
j
h

 β j − β h , H1
 βˆ − d

σˆ βˆ − βˆ ,H
d
| H1 
= Pr  1
> j h 0 ⋅ z1−α / 2 −
 σˆ ˆ ˆ

σˆ βˆ − βˆ ,H
σˆ βˆ − βˆ ,H
1
1
j
h
j
h
 β j − β h , H1

 σˆ βˆ − βˆ ,H
d
= 1 − Φ  j h 0 ⋅ z1−α / 2 −
 σˆ ˆ ˆ
σˆ βˆ − βˆ ,H
1
j
h
 β j − β h , H1


,



where Φ() is the standard normal density function, and α and β are the probabilities of type I and type II error,
respectively. For a one-sided test, α is used in place of α/2.

Covariance Patterns
In a repeated measures design with N subjects, each measured m times, observations from a single subject may be
correlated and a pattern for their covariance is specified. In this case, V will have a block-diagonal form and can
be written as
 V1

0
2
V =σ R = 0

 
0


0
V2
0

0

0
0
V3

0

 0 

 0 
 0 

  
 VN 

where Vi are m × m covariance matrices corresponding to the ith subject. The 0's represent m × m matrices of zeros
giving zero covariances for observations on different subjects. This routine allows the specification of four
different covariance matrix types: Compound Symmetry, AR(1), Banded(1), and Simple.
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Compound Symmetry
A compound symmetry covariance model assumes that all covariances are equal, and all variances on the
diagonal are equal. That is
1

ρ
ρ
Vi = σ 2 
ρ


ρ


ρ
ρ

ρ

ρ  ρ

ρ  ρ
ρ  ρ

1  ρ







ρ

ρ

ρ
1

ρ
ρ
1

 

ρ  1  m×m

where σ 2 = var( y ij ) and ρ is the correlation between observations on the same subject.

AR(1)
An AR(1) (autoregressive order 1) covariance model assumes that all variances on the diagonal are equal and that
covariances t time periods apart are equal to σ 2 ρ t . That is
 1

 ρ
 2
ρ
Vi = σ 2  3
 ρ

 
 ρ m −1


ρ

ρ2
ρ

1

ρ
ρ2

ρ





1

ρ m −2

ρ3
ρ2
ρ
1


ρ m −3 ρ m − 4








ρ m −1 

ρ m −2 
ρ m −3 
ρ m −4 


 
1  m×m

where σ 2 = var( y ij ) and ρ is the correlation between observations on the same subject.

Banded(1)
A Banded(1) (banded order 1) covariance model assumes that all variances on the diagonal are equal, covariances
for observations one time period apart are equal to σ 2 ρ , and covariances for measurements greater than one time
period apart are equal to zero. That is
1

ρ
0
Vi = σ 2 
0


0


ρ

0

1

ρ

ρ

1

0

ρ


0


0

0  0

0  0
ρ  0

1  0
  

0  1  m×m

where σ 2 = var( y ij ) and ρ is the correlation between observations on the same subject.
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Simple
A simple covariance model assumes that all variances on the diagonal are equal and that all covariances are equal
to zero. That is
1

0
0
Vi = σ 2 
0


0






   
0 0 0 

0
1
0
0

0
0
1
0

0
0
0
1

0

0
0

0


1  m×m

where σ 2 = var( y ij ) .

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and
power. This chapter covers two procedures, each of which has different options. This section documents options
that are common to both procedures. Later, unique options for each procedure will be documented.

Solve For
Solve For
This option specifies the parameter to be solved for. When you choose to solve for sample size, the program
searches for the lowest sample size that meets the alpha and beta criterion you have specified for each of the
terms. The "solve for" parameter is displayed on the vertical axis of the plot.

Test
Test Statistic Based On
This option specifies the type of test statistic for which power is calculated. This routine has the capability of
calculating power and sample size for testing time-averaged differences for binary data based on two different test
statistics. The options are as follows:
•

Difference: P1-P2
This option calculates the power for the test statistic based on the difference in proportions:

z=

pˆ 1 − pˆ 2
.
var( pˆ 1 − pˆ 2 )
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•

Log(OR): logit(P1)-logit(P2)
This option calculates the power for the test statistic based on the difference defined on the logit link scale:
z=

logit( pˆ j ) − logit( pˆ h )
var(logit( pˆ j ) − logit( pˆ h ))

.

Alternative Hypothesis
This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. The
null hypothesis is always H 0 : β1 = 0 .
Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
Possible selections are:
•

One-Sided
This option yields a one-tailed test. Use it for testing the alternative hypotheses H 1 : β1 > 0 or H 1 : β1 < 0 .

•

Two-Sided
This is the most common selection. It yields the two-tailed test. Use this option when you are testing whether
the means are different, but you do not want to specify beforehand which mean is larger.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
Input Type
Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the test
statistics used in the power and sample size calculations are the same. This option is simply given for convenience
in specifying the effect size.
P1 (Group 1 Proportion|H1)
This option is displayed only if Input Type = “Proportions”
Enter a value for the proportion of 'successes' in group 1 under the alternative hypothesis. If you know the
expected odds ratio for the two treatment groups, click on the 'P' button to the right to calculate the corresponding
proportions. You may enter a single value or a range of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1. The items
in the list may be separated with commas or blanks.
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OR (Odds Ratio|H1 = O1/O2)
This option is displayed only if Input Type = “Odds Ratios”
Enter a value for the odds ratio for that is to be detected. If you know the expected proportions for the two
treatment groups but do not know the odds ratio, click on the “OR” button to the right to calculate the
corresponding odds ratio. The odds ratio is used along with P2 to calculate P1 using the formula: P1 =
(OR*P2)/(1 - P2 + OR*P2). You may enter a single value or a range of values such as 1.5 2 2.5 or 1.5 to 2 by 0.1.
The items in the list may be separated with commas or blanks.

Effect Size – Group 2 (Control) Proportion
P2 (Group 2 or Control Proportion)
Enter a value for P2, the baseline proportion, or the proportion of “successes” from group 2. You may enter a
single value or a range of values such as 0.1 0.2 0.3 or 0.1 to 0.3 by 0.05. The items in the list may be separated
with commas or blanks.

Effect Size – Repeated Measurements
M (Number of Time Points)
Enter a value for the number of time points (repeated measurements) for which each subject will be observed.
You may enter a single value or a range of values such as '3 5 7' or '2 to 8 by 1'. The items in the list may be
separated with commas or blanks.

Effect Size – Covariance Structure
Covariance Type
Select the within-subject covariance structure that will be used in the mixed models analysis. The options are:
•

Compound Symmetry
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ 2 , and all
covariances are equal to ρσ 2 .

•

AR(1)
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ 2 , and the
covariance between observations t time periods apart is ρ tσ 2 .

•

Banded(1)
All variances on the diagonal of the within-subject variance-covariance matrix are equal to σ 2 , and the
covariance between observations one time period apart is ρσ 2 . Covariances between observations more than
one time period apart are equal to zero.

•

Simple
All variances are equal to σ 2 , and all covariances are equal to zero.

Rho (Autocorrelation)
Enter a value for the correlation between observations on the same subject. When no previous estimate of the
within-patient correlation is available, you should use a conservative prediction of the correlation, i.e. a
correlation that is higher than anticipated. You may enter a single value or a range of values such as 0.5 0.6 0.7 or
0.4 to 0.9 by 0.1. The items in the list may be separated with commas or blanks.
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Example 1 – Determining Power
A study is being planned to determine the efficacy of a prophylactic treatment for the common cold. The study
will follow a treatment group and placebo control group through the winter to determine if there is an overall
difference between the two treatment groups in the proportion of patients who get sick. Subjects will take the
treatment (or placebo) once daily throughout the duration of the study. The study will be conducted from
September to April with scheduled, monthly visits (beginning in October) to determine the patient's disease status
(present or absent). Therefore, a total of seven responses will be observed for each patient. Previous studies have
indicated a baseline disease rate of 60% for the common cold. The researchers want to be able to detect a
treatment to control odds ratio of 0.5 (an odds ratio of 0.5 corresponds to a treatment group proportion of
0.4285714). A compound-symmetry covariance pattern with autocorrelation of 0.5 is assumed to be adequate.
The test will be conducted using a mixed models analysis with an alpha level of 0.05.
What power does the study achieve over a range of possible sample sizes?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 10 to 100 by 10
Input Type ............................................... Proportions or Odds Ratios
P1 (If using Proportions) ......................... 0.4285714
OR1 (If using Odds Ratios) .................... 0.5
P2............................................................ 0.6
M ............................................................. 7
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Test Statistic Based on Log(OR): logit(P1) - logit(P2).
Two-Sided Test. Null Hypothesis: OR = 1. Alternative Hypothesis: OR ≠ 1.
Covariance Type = Compound Symmetry
Power
0.17843
0.30742
0.42768
0.53515
0.62800
0.70610
0.77040
0.82241
0.86386
0.89646

N1
10
20
30
40
50
60
70
80
90
100

N2
10
20
30
40
50
60
70
80
90
100

N
20
40
60
80
100
120
140
160
180
200

M
7
7
7
7
7
7
7
7
7
7

P1
0.429
0.429
0.429
0.429
0.429
0.429
0.429
0.429
0.429
0.429

P2
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600
0.600

OR1
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

Rho
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
M is the number of time points (repeated measurements) at which each subject is observed.
P1 and P2 are the proportions from groups 1 and 2, respectively.
OR1 is the odds ratio ((P1/(1-P1))/(P2/(1-P2))) to be detected.
Rho is the correlation between observations on the same subject.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
Group sample sizes of 10 and 10 achieve 17.843% power to detect an odds ratio of 0.500 in a
design with 7 repeated measurements having a Compound Symmetry covariance structure when the
proportion from group 2 is 0.600, the correlation between observations on the same subject is
0.500, and the alpha level is 0.050.

This report gives the power for each value of the other parameters.
Power
This is the computed power for detecting the time-averaged difference between the two group means.
Group 1 Sample Size (N1)
The value of N1 is the number of subjects in group 1.
Group 2 Sample Size (N2)
The value of N2 is the number of subjects in group 2.
Time Points (M)
This is the number of repeated measurements taken.
Group 1 Prop (P1) & Group 2 Prop (P2)
These are the proportions of successes in groups 1 and 2, respectively.
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Odds Ratio (OR1)
This is the value of the odds ratio under the alternative hypothesis.
Autocorr. (Rho)
This is the correlation between observations from the same subject.
Alpha
Alpha is the significance level of the test.
Beta
Beta is the probability of failing to reject the null hypothesis when the alternative hypothesis is true.

Plots Section
Using Proportions

Using Odds Ratios

The chart shows the relationship between power and N1 when the other parameters in the design are held
constant.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to determine the exact sample size necessary to achieve at least
80% power.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Input Type ............................................... Proportions or Odds Ratios
P1 (If using Proportions) ......................... 0.4285714
OR1 (If using Odds Ratios) .................... 0.5
P2............................................................ 0.6
M ............................................................. 7
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Target
Power
0.80

Actual
Power
0.80297

N1
76

N2
76

N
152

M
7

P1
0.429

P2
0.600

OR1
0.500

Rho
0.500

Alpha
0.050

A group sample size of 76 is required to achieve at least 80% power.
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Example 3 – Varying the Odds Ratio
Continuing with Examples 1 and 2, the researchers want to evaluate the impact on power of varying the odds ratio
from 0.4 to 0.8. In the output to follow, we only display the plots. You may want to display the numeric reports as
well, but we do not here in order to save space.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 10 to 100 by 10
Input Type ............................................... Odds Ratios
OR1......................................................... 0.4 to 0.8 by 0.1
P2 ........................................................... 0.6
M ............................................................. 7
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Plots Section

These charts show how the power depends on the odds ratio, OR1, as well as the group sample size N1.
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Example 4 – Varying the Proportions
Continuing with Examples 1 and 2, the researchers want to evaluate the impact on power of varying the group 1
proportion from 0.2 to 0.5. In the output to follow, we only display the plots. You may want to display the
numeric reports as well, but we do not here in order to save space.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 10 to 100 by 10
Input Type ............................................... Proportions
P1............................................................ 0.2 to 0.5 by 0.1
P2 ........................................................... 0.6
M ............................................................. 7
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Plots Section

These charts show how the power depends on the proportion, P1, as well as the group sample size N1.
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Example 5 – Impact of the Number of Repeated Measurements
Continuing with Example 2, the researchers want to study the impact on the sample size if they changing the
number of measurements made on each individual. Their experimental protocol calls for seven measurements.
They want to see the impact of taking twice that many measurements.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 5 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Input Type ............................................... Proportions or Odds Ratios
P1 (If using Proportions) ......................... 0.4285714
OR1 (If using Odds Ratios) .................... 0.5
P2 ........................................................... 0.6
M ............................................................. 7 14
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Target
Power
0.80
0.80

Actual
Power
0.80297
0.80161

N1
76
71

N2
76
71

N
152
142

M
7
14

P1
0.429
0.429

P2
0.600
0.600

OR1
0.500
0.500

Rho
0.500
0.500

Alpha
0.050
0.050

Doubling the number of repeated measurements per individual decreases the group sample size by only 5
individuals. This reduction in sample size may not justify the additional seven trips to the clinic for each subject.
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Example 6 – Validation using Diggle et al. (1994)
Diggle et al. (1994) pages 31 and 32 present an example of calculating the sample size for a TAD study. They
calculate the group sample sizes for the cases where the difference in proportions (P1-P2) ranges from 0.1 to 0.3,
ρ ranges from 0.2 to 0.8, alpha = 0.05, p2 = 0.5, M = 3, and power = 0.8. Note that Diggle et al (1994) uses a onesided test and the test statistic based on the difference in proportions.
To calculate the sample sizes using the odds ratio specification, we must first convert the differences to odds
ratios using the formula:
OR =

p1 /(1 − p1 )
p 2 /(1 − p 2 )

Differences of 0.1, 0.2, and 0.3 with P2 = 0.5 correspond to odds ratios of 1.5, 2.333, and 4.0, respectively.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 6 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Test Statistic Based on ........................... Difference: P1-P2
Alternative Hypothesis ............................ One-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Input Type ............................................... Proportions or Odds Ratios
P1 (If using Proportions) ......................... 0.6 0.7 0.8
OR1 (If using Odds Ratios) .................... 1.5 2.333 4
P2 ........................................................... 0.5
M ............................................................. 3
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.2 0.5 0.8
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Target
Power
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80

Actual
Power
0.80164
0.80116
0.80089
0.80870
0.80163
0.80329
0.82213
0.81509
0.81120

N1
143
204
265
35
49
64
15
21
27

N2
143
204
265
35
49
64
15
21
27

N
286
408
530
70
98
128
30
42
54

M
3
3
3
3
3
3
3
3
3

P1
0.600
0.600
0.600
0.700
0.700
0.700
0.800
0.800
0.800

P2
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500
0.500

OR1
1.500
1.500
1.500
2.333
2.333
2.333
4.000
4.000
4.000

Rho
0.200
0.500
0.800
0.200
0.500
0.800
0.200
0.500
0.800

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

The sample sizes calculated by PASS match the results of Diggle et al. (1994) exactly.
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Example 7 – Validation using Brown and Prescott (2006)
Brown and Prescott (2006) page 270 presents an example of calculating the sample size for a future study. They
calculate the group sample size to be 85 for a future study involving four post-treatment visits to detect a doubling
of the odds ratio (i.e., OR1 = 2) at the 5% significance level with 80% power. They assume an autocorrelation of
0.5, and an expected rate of positives ((P1+P2)/2) of 0.4. We can calculate the corresponding values of P1, P2,
and OR for use in PASS by solving the following system of equations for P1 and P2:
P1 + P 2
= 0.4 and
2

P1 /(1 − P1)
= OR = 2.0
P 2 /(1 − P 2)

The solution to these equations occurs when P1 = 0.482255312124 and P2 = 0.317744687876. The decimal
places are kept to make the solution exact.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions in a Repeated Measures Design procedure window by expanding
Proportions, then Two Independent Proportions, then clicking on Repeated Measures, and then clicking on
Tests for Two Proportions in a Repeated Measures Design. You may then make the appropriate entries as
listed below, or open Example 7 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Test Statistic Based on ........................... Log(OR): logit(P1)-logit(P2)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Input Type ............................................... Proportions or Odds Ratios
P1 (If using Proportions) ......................... 0.482255312124
OR1 (If using Odds Ratios) .................... 2.0
P2 ........................................................... 0.317744687876
M ............................................................. 4
Covariance Type..................................... Compound Symmetry
Rho ......................................................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Target
Power
0.80

Actual
Power
0.80080

N1
86

N2
86

N
172

M
4

P1
0.482

P2
0.318

OR1
2.000

Rho
0.500

Alpha
0.050

The sample size of 86 calculated by PASS matches the results of Brown and Prescott (2006). The slight difference
is due to rounding. Calculation of the sample size presented by Brown and Prescott (2006) on page 270 results in
a value of 85.025337, which they round down to 85. Note that the numerical formula has a typographical error:
the denominator term should be (4 × .6932), not (4 × .693)2 (see the formula on page 269 of Brown and Prescott
(2006)).
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